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I. INTRODUCTION 

A. Mandatory Electronic Filing:

Local Bankruptcy Rule (LBR) 5005-1 became effective on April 3, 2006, requiring

attorneys who regularly practice and trustees assigned cases in the Eastern

District bankruptcy court to file documents in electronic form [see LBR 5005-1(c) 

for exceptions] and in strict compliance with instructions of the Clerk in a format

approved by the Court.

B. Excepted Documents:

Documents in all bankruptcy cases and related proceedings are eligible for

electronic filing with the following exceptions: 

o Requests to file documents under seal; 

o Documents filed under seal; 

o Documents filed by unrepresented persons; 

o Trial exhibits; 

o Alternate direct testimony; and 

o Exhibits to alternate direct testimony. 

These documents shall be filed conventionally, in paper form.

II. ELECTRONIC FILING HARDWARE AND SOFTWARE REQUIREMENTS

To file cases and documents electronically, a user must have certain computer hardware

and software, as well as access to the Internet. In most instances, you likely have all the

hardware and software you will need in order to participate in the e-Filing program with

the one exception of the PDF file creator. More about that later.

To be certain as to what you need, required minimum and optimum specifications for

electronic filing are provided in Exhibit 1. Required minimum specifications should be

used to predict whether or not your existing hardware will perform adequately.

Recommended optimum specifications should be used as a guide for those purchasing

new equipment and services.

Required minimum and optimum specifications are subject to change and it is likely that

faster, greater capacity equipment will be needed in the future.  Therefore, users are

encouraged to purchase the fastest computers and connections they can within budget

constraints, even beyond what is recommended. Updated system specifications will be

posted on the court’s Internet web site at www.caeb.uscourts.gov.

III. REGISTRATION FOR ELECTRONIC FILING

Before you can access and use the court’s e-Filing W eb application, you must complete

the electronic Registration Form and User Agreement.  The registration form is available

on the court’s website by clicking on the e-Filing Registration link.  Approved users will

be assigned a username and password to access the e-Filing system.  Users will be
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notified of assigned user name and password by e-mail. 

All e-Filers will be expected to keep the information associated with their e-Filing user

accounts current themselves by entering address and/or phone number changes directly

in the e-Filing system. [See Section VII. ACCESSING THE E-FILING SYSTEM AND

DOCUMENT SUBMISSION]

IV. DOCUMENT CREATION AND FORMATTING

Documents may be created using any word processing application, however all

documents must be converted to Portable Document Format (PDF) prior to filing

electronically with the court. If you attempt to upload a non-pdf file an error message will

display.

Documents shall be prepared in compliance with Local Bankruptcy Rule 9004-1(a), as

well as the court’s Revised Guidelines for Preparation of Documents, Form EDC 2-901

and General Orders 06-02 and 04-01.

Every signature line in an electronically filed document must indicate a signature. 

Options include submitting a scanned copy of the originally signed document; attaching

a scanned copy of the signature page(s) to the electronic document; or, by typing /s/

followed by the name of the person signing the document. 

The use of “/s/ Name” on documents to indicate the signature of persons other than the

electronic filer constitutes the electronic filer’s representation that an originally signed

document exists and is in the filer’s possession at the time of filing.  Retention of

executed originals of all pleadings and other documents signed under oath is required

(see General Order 06-02).  An example of the “/s/ Name” signature follows:

Law Office of John H. Smith

By: /s/ John H. Smith

Attorney for Debtor

PROOFREAD THE DOCUMENT BEFORE AND AFTER YOU CONVERT IT TO PDF. 

Make sure all blanks in the documents for dates, times, amounts, etc. are filled in,

especially if the document was created using a form. For verified pleadings that are not

scanned, type in the information applied to the executed document, such as a date and

a notary’s stamp. 

W hen creating documents in a word processing application, you may wish to consider

the creation of a folder for each case in which to save the documents, as well as the

messages you will receive back from the court. To easily track documents that are not

part of a batch upload, you may also wish to consider development of some type of file

naming convention. For example, you may want to use the case number and

abbreviations for the type of document being filed. (i.e. 322345rs is the equivalent of

case number 03-22345 Motion for Relief from Stay). For documents that are a part of a

batch upload, there is a strict file naming convention for each type of document accepted
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by the court. Please refer to Exhibit 5 for instructions on naming batched PDF files, or

Exhibit 6 for a quick reference guide to the batch e-Filing naming conventions. 

V. CREATING THE PDF DOCUMENT 

The simplicity of e-Filing will easily change the way many attorneys and trustees will do

business with the court. Being able to file from anywhere there is an Internet connection,

24 hours a day irrespective of weekends or holidays, makes e-Filing a very compelling

alternative to conventional document filing.  The process begins with the creation of the

PDF document. 

Remember that the court accepts electronic documents in only one format, PDF. All

documents must be converted to PDF before being submitted to the court. The reason

for requiring files to be converted to PDF is that PDF is a true visual representation of an

original document. It retains original document pagination, formatting, colors, and fonts.

PDF is the perfect choice for document submission and is the mandatory file format for

electronic filing. 

There are two primary methods for creating PDF documents: by formatting text

documents into PDF at the time of creation OR by scanning imaged documents from

paper into PDF.

A. Creating PDF documents by formatting text documents from a word 

processing package

The optimal method for creating a PDF document for filing in CM/ECF is a simple

method:  create it directly from a word processing application using Adobe PDF. 

PDF files created in this way have the advantage of a much smaller file size than

documents that have been scanned. This is the preferred method for creating a

PDF file from a word processing application. 

Conversion of most word processing documents to PDF format is relatively

simple depending on the word processing program being used. As a general

rule, it is no more difficult than sending your document to a printer to be printed

or scanning a document not in word processing format. 

W hile we recommend that you purchase a copy of Adobe PDF for creating PDF

files, we do recognize that the newer versions of W ordPerfect have built-in PDF

generation capabilities.  Our lab tests have proven however, that PDF files

created with the W ordPerfect PDF generator do not consistently produce a true

representation of the original document.
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For WordPerfect version 9 and 11 WITH Adobe software installed:

" Open the document to be converted. 

" Select the PRINT option and in the dialog box select the option to change

the selected printer. A menu with your list of printer choices is displayed.

" Select Adobe PDF.

" Click PRINT.  The file will not actually print; instead the option to save the

file  as a PDF format file appears.

" Name the file.  Remember that if your PDF document is intended to be

part of a batch upload, there is a strict naming convention. 

" Click Save to convert your word processing document to a

PDFdocument.

For WordPerfect version 9 and 11 WITHOUT Adobe software installed:

NOTE: Content corruption seems to be a frequent occurrence when using

this method. We do not recommend this method. However, if this

method has to be used, your firm must practice more extensive

quality control measures.

" Open document.

" Click on the File menu and select Publish to PDF.

" Save the file as a PDF file, which gives it a .pdf extension. 

" The file is now in Adobe PDF format under the newly designated name,

and the original document remains in its original form under the original

name.

For Microsoft Word WITH Adobe software installed: 

" Open the document to be converted.

" Select the PRINT option and in the dialog box select the option to change

the selected printer. A drop down menu with a list of printer choices is

displayed.

" Select Adobe PDF

" Click OK. The file will not actually print; instead the option to save the file

as a PDF format file appears.

" Name the file. Remember that if your PDF document is intended to be

part of a batch upload, there is a strict naming convention. 

" Click Save to convert your word processing document to a PDF

document.
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B. Creating PDF documents from a scanning system

For those documents that must be imaged because a word-processed version

does not exist, the preferred method is to scan the document directly into PDF

format using Adobe Acrobat (from the File menu, choose Import/Scan). Scanning

to a format other than PDF (e.g., TIFF) would add both delay and labor, requiring

not only the scan but then a conversion to PDF.

There are several factors to consider when determining how the scanning will be

done. The quality of the document when scanned is determined by the level of

detail recorded by the scanner. This detail is referred to as the resolution, which

is measured by the dots per inch (dpi). A higher resolution is slower to scan (this

is dependent also on the scanner and the number of pages that are scanned)

and creates a document with a larger file size. This, in turn, will cause retrieval of

the document to be slower.  Documents scanned for electronic filing in the U.S.

Bankruptcy Court for the Eastern District of California should be scanned at 300

dpi. The maximum size for a PDF file is 8 to 10 mega bites.  

Another factor to consider is the mode of scanning. Almost always, it should be

done in black and white, so that the file size will be as small as possible.

However, there are some documents (those with shaded boxes, for example)

that may need grayscale instead; this, however, will produce a file that is much

larger in size than the document scanned in black and white.  Never scan in color

unless absolutely necessary (perhaps for exhibits originally produced in color).

This, too, will produce a document with an extremely large file size, which will

take longer to retrieve for viewing purposes.

C. Adding PDF documents to a Zip file for batch processing

There may be many times when it is more convenient to submit multiple files to

the court in a single batch upload. To do this, multiple PDF files must be bundled

together into a single archive file called a Zip file.  These PDF files must be

named according to the naming conventions outlined in Exhibit 5. Any departure

from the naming conventions/rules will cause rejection of the submitted files. 

After saving and naming your PDF files, complete the following steps to create a

Zip file using W inZip software.

" Highlight all of the files containing PDF documents you wish to include in

the batch. 

" Right click and select the "W inZip" option on the expanded menu

selection, and then the "Add to Zip File" option.

" Click the "New" button and browse to the directory where you would like

your Zip file created. Enter a name for the Zip file in the "File Name" text.

Note: There is no Zip file naming convention to follow.

" Then Click the "Add Button"

" You should now see a list of all your PDF files in the W inZip interface's

window. You will also note that a Zip file has been created in the directory

and with the name you indicated. This file is the file you will upload to the

court as a batch submission. The Zip file name has no naming convention

to follow. It is only a container for your PDF files. 
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VI. CREATING THE MASTER ADDRESS LIST 

Electronically filed master address lists shall contain a list of creditor names and

addresses, prepared in strict compliance with the Name and Address Standards set

forth in form EDC 2-190, Revised Guidelines for the Preparation of Master Address

Lists, and saved in a “pure text” format (not delimited), such as MS-DOS text or ASCII

(DOS) text, with a .txt filename extension.  Refer to the E-filed Master Address List

Instructions located under the e-Filing Resources from the home page of the court’s web

site.   Electronically filed master address lists saved in word processing format, a

delimited text format, or a generic word processor text format or without a .txt filename

extension will not be uploaded. 

VII. ACCESSING THE E-FILING SYSTEM AND DOCUMENT SUBMISSION 

W ith your computer turned on, execute your web browser. This is usually accomplished

by pressing an icon on your computer’s desktop. Once the browser is running, enter the

courts home web address in the box entitled ‘Address’. This box is near the top of your

opening web page.  The court’s Internet address is www.caeb.uscourts.gov. You will see

the web page, which is the starting point for e-Filing.

From the court’s Internet home page, select e-Filing W ebsite located under the

Electronic Filing section in the upper left side of the page.
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Enter the User Name and Password received from the court.  You must also click the

redaction verification button to the right of the login.

 If you have not previously registered and do not have a username, you may register

online by clicking on CLICK HERE TO REGISTER ONLINE NOW .  If you have forgotten

your login, click on the link “Forgot your username or password?” and enter your email

address.  Your current login and password will be provided to you via email.   A

successful login will display the screen on the following page.
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The update address link appears on this screen to allow you to update your address in

the court’s system and will allow you to associate it with all future filings and if desired all

previously filed cases.   It is the e-Filer’s responsibility to keep his/her address current.   

NOTE: Non-attorney e-Filers will not see any address displayed as this information is

stored in a different data base.  Non-attorney e-Filers will need to continue to contact the

Clerk’s office with their address change requests.

To upload documents one at a time, press the Single File Upload button and follow the

instructions in section A.  To upload batched documents, press the Batch Upload button

and follow the instructions in section B.
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A. Single document submission

Before entering data, verify that the document you wish to file is eligible for e-Filing.  A

list of the Documents Excepted from Electronic Filing is located in  Exhibit 2.  The list

can also be accessed by clicking the Help tab on the e-Filing screen.  Once you have

verified that the document you wish to file is eligible for e-Filing, enter the required

information according to the indicated format.

Click on the drop down arrow ? and highlight a Filing Type and then click Next. A list of

available Filing Types is located in  Exhibit 3.
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The case number is a required field and must be entered in the format indicated to the

right of the case number field (see example on the previous page).   In the case of a

voluntary petition, enter the first five digits of the debtor’s zip code.  The zip code in the

address on the petition is used to establish venue.  

The adversary number and DCN number are optional fields.  If used, they must be

formatted as shown to the right of their respective fields.

Select a Document Type and Sub-Type, if required, from the drop down ? boxes.   A list

of available document types and document subtypes is located in Exhibit 3.  [Note:

Document Type/Subtypes are used by the system to prioritize and identify e-File

documents.  They are not used for docketing purposes.]
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Next, click on the Browse button.  Highlight the PDF file for submission and click the

Open button.  The selected file will display on the List of Files to be Uploaded. 

Continue selecting additional Document Types until all related documents have been

selected and each item is displayed on the List of Files to be Uploaded as in the

example below.  For example, when filing a voluntary petition, the other documents

related to that petition (such as the master address list as a text file, verification of

master address list form, statement of social security number, etc.) should be placed on

the list and submitted with the petition.
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In the example on the previous page, after the motion and all related documents have

been selected click the Continue button to proceed.

If your submission includes Voluntary Petitions for Chapter 7, 11, 12, or 13 cases you

will be prompted to provide additional new case statistical data.

You can provide this additional information in one of two ways.  You can enter the new

case data manually by clicking on the Enter New Case Data Manually button.  If you

are using petition preparation software you can upload your new case data file

(debtor.txt) by clicking on the Upload New Case Data File button.  This file will need to

conform to the CM/ECF Bankruptcy Release 3.3 Case Upload File Definition as provided

by the PACER Service Center.

If you select the Enter New Case Data Manually option you will be presented with the

following pop-up window.  After you have completed all the required information, click on

the Continue button to proceed with your submission.
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The Submission Verification screen appears confirming that the documents listed are the

documents you wish to submit for filing with the court and are ready to pay the

associated fee(s) listed.

 

Note the PDF icon allowing you one last time to verify that the document you are about to

submit to the court is accurate.  If it is the incorrect PDF, click on the Discard

documents listed above and start the process over.

If your documents are correct, click on the button Submit documents listed above to

the court.  

You have completed the document processing and are now ready to Proceed W ith

Payment to fully complete your transaction.
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B. Batch document submission

Many PDF files may be batched into one Zip file and uploaded by pressing the Batch

Upload button located on the Electronic Case Filing screen. Note: You can access this

screen at any time by clicking on e-File Document at the top of the screen.  The Batch

Submission screen will appear.

Click the radio button to the left of the type of batch you wish to upload. For PDF file

naming conventions and instructions on how to create a Zip file, click on the name of the

batch type or on Help at the top of the screen.
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After selecting a batch type, press the Browse button and search for the Zip file to

upload, then click on Open.  Press the Submit button to upload your batch. Please note

that once the Submit button has been pressed, you cannot undo the submission. Should

you realize that a mistake was made, contact the case manager assigned to your case. 
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If your batch is of type Voluntary Petitions or Chapter 7 Petitions Batched for

Trustee Assignment you must include the new case statistical information.

If your zip file contained the new case statistical file, you will see the following screen

stating that statistical data has been received.  Click on the Continue button to proceed. 

If your zip file did not contain the statistical file, you will see the message Enter

Statistical Data in the Status field.  Click on the Enter Data Manually button to provide

the new case statistical information.  After you have completed all the required

information, click on the Continue button to proceed with your submission as previously

described on page 14.
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The Submission Verification screen appears confirming that the documents listed are the

documents you wish to submit for filing with the court and are ready to pay the

associated fee(s) listed.  As mentioned previously under the Single File Upload, the PDF

icon appears next to the file name, allowing one last review of the document before

submission to the court.

If your documents are correct, click on the button Submit documents listed above to

the court.   You have now completed the batch upload process and are now ready to

Proceed With Payment.
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If your submission contains errors, it cannot be processed.  A message will display a list

of the files with errors as an aid to correct them.  Once the corrections have been made,

resubmit the entire batch. 

After printing the submission summary page, you may submit additional documents for

filing, check the status or history of electronically filed documents, or exit the program.

You may do this anytime day or night, for documents submitted by you.  It is the Court’s

preference that you Proceed with Payment after each transaction.
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To check the filing status or history of any submission, click the e-File History tab. 

Information concerning your submissions will appear and the status of each will be

shown in the middle of the screen.  Possible statuses are SUBMITTED, PROCESSING,

DOCKETED, SUCCESSFUL, and DELETED.

Please see the table below for explanations of the document processing workflow. 

Status  Workflow Explanations 

SUBMITTED You have pressed the Submit button and your submission has been

received by the court and is waiting processing. 

PROCESSING The process of electronically file stamping and moving your submission

into our image system has begun. An e-mail containing the

confirmation number, the filed date, and a summary of the submission

details will be sent to the filer. 

DOCKETED The docketing of your submission is complete. 

SUCCESSFUL Your submission is complete and available on the internet. An e-mail

will be sent to the filer and to designated parties.

DELETED The submission has been deleted by the case manager. 

If you have completed all e-Filing submissions for the current session, click on Sign Out at

the top of the screen to exit the application.
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VIII. POST DOCUMENT SUBMISSION

Documents submitted electronically will be processed at specified intervals throughout the

workday. During processing, a filed stamp will be affixed to the imaged document.

W hen processing is complete and the imaged document is available on PACER, the filer

and any other registered users of the electronic filing system who have appeared in the

case will be sent a Notice of Electronic Filing e-mail message containing document

submission and docketing information, as well as a hyperlink to the document.  Although

you will be prompted to use your PACER login and password, this hyperlink bypasses

the PACER billing system and provides “one free look” at the image of the document.

The “free look” hyperlink may be used only once and will expire after 15 days if not used.

Any further attempt to use the link will provide access through the PACER billing system,

and you will be charged $.08 per page.

For a Proposed Order, you will receive the Notice of Electronic Filing after it has been

signed by the Judge.

You will receive a Notice of Electronic Filing for a Statement of Social Security Number,

but you will not be able to access the image using the “free look” hyperlink because the

image has restricted access for observation of privacy issues. 

Some Internet browser or e-mail settings may insert the web site addresses (URL) for

the “free look” documents in the text of the Notice of Electronic Filing.  If you receive an

error message such as “The page cannot be displayed” or “…must supply docno or

claimno” when you click a URL (instead of the hyperlink) in the Notice of Electronic Filing

message text, highlight the entire URL (it may span two or more lines), copy it, paste it

on the Internet address line near the top of your browser screen, and press return on the

keyboard. This should link you to the document. If the URL in text is only partially

displayed as an active link (some of the text is on a second line, is not underlined and is

a different color than underlined text), you may also be able to access the document by

integrating the second line of the URL with the first by removing the line break or

carriage return at the end of the first line.  W hen this is properly done, the entire text of

the URL will be the same color, underlined and when clicked, will link you to the

document. 

Electronic filers will also receive notice of deficient e-Filed documents. Continued failure

to properly prepare e-Filed documents may result in suspension or revocation of e-Filing

privileges.
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